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The OLYMPUS Stream documentation 
1 The OLYMPUS Stream documentation

Documentation for the OLYMPUS Stream software is made up of several parts: the Quick Setup
Guide, this installation manual, the online help, the user's manual and the database manual. 

The Quick Setup Guide is delivered with your software. It provides important information about the
software activation and the system requirements. 

In this installation manual, you can learn how to install, configure, and uninstall OLYMPUS Stream.
The manual provides additional information about the system requirements and the software
activation and deactivation. 

In the user manual, you can find both an introduction to the product and an explanation of the user
interface. With the help of the extensive step-by-step instructions, you can quickly learn the most
important procedures for using your software. You can find the manual saved as a PDF file in the
software's installation directory.

In the online help, you can find detailed help for all elements of your software. An individual help
topic is available for every command, every toolbar, every tool window and every dialog box. Open
help with the [Shift + F1] shortcut. Alternatively, if you have a dialog box open, you can click the
question mark in its top right corner.

New users are advised to use the user manual to familiarize themselves with the product and to use
the online help for more detailed questions later.

The database manual applies to OLYMPUS Stream database users and administrators. It describes
the work with databases and how databases are set up and managed. You can find the manual
saved as a PDF file in the software's installation directory. The database manual is currently available
in English, German and French. If you install OLYMPUS Stream in another language, the English
PDF file is installed. 
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System requirements
2 System requirements

The following system requirements are necessary to run OLYMPUS Stream: 

CPU Intel Core i5, i7 (recommended)
Intel Core 2Duo (minimum)

Operating system Microsoft Windows 8.1 Pro (64 bit)
Microsoft Windows 8.1 Pro (32 bit)
Microsoft Windows 7 Ultimate/Professional (64 bit)
Microsoft Windows 7 Ultimate/Professional (32 bit)
Microsoft Windows Server 2012
Microsoft Windows  Server 2008 R2
Microsoft Windows  Server 2008

RAM 8 GB (recommended)
3 GB (minimum)

Graphics card 2048 MB RAM (recommended)
512 MB RAM (minimum)

Screen resolution 1280x1024 with a 32-bit graphics card

Free storage space on your 
hard disk

You need to have 2.4 GB of free hard disc drive space in order to 
install the software.
If the PC where OLYMPUS Stream is installed is also intended to 
be used for storing the data created by Stream, you will need a 
correspondingly larger hard disk (at least 50 GB).

Ports Dual Layer DVD drive
USB 3.0, USB2-ICH7 or FireWire (IEEE1394) port for your cam-
era
COM interface (RS232) for motorized microscopes, stages, 
objective encoders, zoom encoders

Software for working with 
reports

In addition to OLYMPUS Stream, for working with reports, MS-
Word, MS-PowerPoint and MS-Excel are required for displaying 
and editing reports. This is why you need Microsoft Office 2013, 
2010 or 2007 (SP3). Install Microsoft Office before installing 
OLYMPUS Stream.
For the software package OLYMPUS Stream Start, you don't 
need Microsoft Office because report generation is not included.

Web browser Microsoft Internet Explorer 8, 9, 10 or 11

Database management sys-
tem

Microsoft SQL Server 2012 Express 
Microsoft SQL Server 2008 Express 
Microsoft SQL Server 2005 Express 
(Microsoft SQL Server Express 2012 can be installed by the 
OLYMPUS Stream setup) 

In addition, the OLYMPUS Stream Enterprise software package 
supports the following database management systems:
Microsoft SQL Server 2005 / 2008 / 2012 (Standard/Workgroup/
Enterprise Edition) 
Oracle 11g R2, Oracle 10g, Oracle XE
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Getting Ready 
3 Getting Ready

1) To install your software, you need to have a valid license key. Be sure to keep the certificate that
includes the license key.

2) The software cannot be installed unless the user account that is used for the installation is
registered as “Computer administrator.”
If the user account is registered as a “Restricted account,” change it to the “Computer adminis-
trator” account.
(For the user account registration, refer to the instruction manuals for your computer.)

3) The image data may be damaged unexpectedly. Please backup the data regularly.

4) Please note: if the camera cable is unplugged while the live image is displayed, the live image
stops. It remains stopped even after the camera cable has been plugged in again. In this case,
restart OLYMPUS Stream and start the live image again.

5) OLYMPUS Stream cannot simultaneously be started twice.

6) Make sure your PC won't start a virus scan process during a time lapse acquisition. The PC
performance may be deteriorated due to the virus scan so that images cannot be acquired with
sufficient accuracy.

7) Before installing the software, read the installation manual of each device that is to be controlled.
Also refer to the corresponding device manuals for any information on how to operate the
connected devices, for example, microscopes.
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Installing the software and camera driver
4 Installing the software and camera driver 

This section describes the installation process using Windows 7. When using Windows 8, the
process is almost the same.

4-1 Installing the software

For the installation keep the following available:
• DVD-ROM
• Certificate containing the main license key
• Certificates containing the license key for an additional software solution (only when you have

purchased a software solution)
• Storage device, e.g. an USB stick (only if the PC on which the software will run has no Internet

connection)

1) Close any and all running application programs. 

2) Place the DVD that has been supplied in your DVD drive.
 The installation program starts automatically. You only need to doubleclick the setup.exe file

if your computer's autorun function has been deactivated. 
 The Select action dialog box opens. 

3) Select the Install or maintain imaging software option.
 The next dialog box is shown.
 The Select action dialog box remains open in the background. After the software installation,

you can select the Install example data or tools option in this dialog box and then install addi-
tional data and tools.

4) Activate your software. The activation is described in chapter "Software activation" on page 11.

5) When the software activation has been completed successfully, continue with the software
installation.
 An installation wizard guides you through the entire software installation. Follow the

instructions of the installation wizard, provide the requested information, then click the Next >
button to continue.
In the following, only some of the installation wizard's dialog boxes are shown.

Install OLYMPUS Stream before you connect your camera with the PC.

To install your software, log on to your PC as administrator.
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Installing the software 
6) Read the license agreement carefully. If
you agree, select the Yes,... option and
click the Next > button.

7) Follow the instructions until the Image
Source Selection dialog box opens. This
dialog box shows a list with all cameras
supported by your software package.
Select the manufacturer on the left side,
then select the check box next to the
camera you want to use with OLYMPUS
Stream from the list on the right side. It is
possible to select several cameras.
 If you select a DP21 or DP26 camera,

the default IEEE1394 device driver is
replaced by an OLYMPUS-specific
IEEE1394 device driver. Because of
this, at this computer, you can only use
other devices which require the stan-
dard IEEE1394 device driver if you
install another IEEE1394 board.

8) Click the Next > button and follow the
instructions in the installation wizard. The
Database dialog box opens. Decide here
whether or not you want to install your own
database management system on this
computer. 
• Select the Use database server in the

local area network option if no data-
base management system should be
installed on this PC. For example, this
option is useful if another PC has been
defined as the database server and all
databases are to be set up in the net-
work. Also select this option if a data-
base management system is already
installed on the PC, and you want to
use it.
8



Installing the software
• Select the Install local database server
option if a database management
system should be installed on this PC.
This means that you can set up
databases on your PC locally at a later
date. The installation then takes much
longer. 

 The installation wizard displays the
Configure Microsoft SQL Server dialog
box in this case. Enter a system admin-
istrator password and don't forget to
take note of this password!

 The installation of the MS SQL Server
2012 database management system
will start after the Stream installation
has been finished.

9) Another Database dialog box opens.
Select here whether or not you want to
define a standard database. 
 The database you select here automat-

ically opens each time you start OLYM-
PUS Stream from now on.

10)Click the Next > button and follow the
instructions in the installation wizard.
9



Installing the software 
11)When you see the dialog box displayed on
the left, click the Finish button
 If you selected the Install local data-

base server option, the installation of
the database management system will
start now. To begin with, the necessary
data will be extracted. This can take
several minutes. Then the SQL Server
2012 Setup dialog box is displayed,
giving current information on the instal-
lation progress. At the end of the instal-
lation, you may be asked to restart the
PC. If this is the case, please do so.

12)At the end of the installation, click the
Close button.
10



Software activation
4-2 Software activation

What is the purpose of software activation?
Software activation is the process to unlock the OLYMPUS Stream software you are about to install
or have already installed for perpetual use. Activating the licenses by electronic means now replaces
the hardware dongle that in former times was required to protect the software against unauthorized
use. Normally, the licenses are activated at the beginning of the software installation. However, you
can also activate your software retroactively, within 30 days after the installation at the latest. When
the software activation has been completed successfully, you possess an activated software license
that is registered on Olympus' central activation server. 

4-2-1 Activation procedure
How the activation is carried out depends on whether an Internet connection can be made or not, and
from which PC. There are three scenarios:

1) Internet-based activation
 If the PC on which the software will run has an Internet connection, the activation automati-

cally takes place via Internet. This is the quickest and easiest scenario which will be used in
most of the cases.

2) File-based activation
 If the PC on which the software will run has no Internet connection, the activation takes place

via another PC that has an Internet connection.

3) Code-based activation
 Alternatively the activation can be done via transferring and entering character codes. You

can do this via your mobile device (for example, smartphone) or by calling the Activation
hotline. Because of the very long codes that must be entered, only choose this scenario when
absolutely no PC with internet connection is available nearby.

Regardless of the activation scenario used, basically always the same data is exchanged between
the client PC and the activation server. These data do not contain any personal information.
11



Software activation 
Basic data exchange during software activation 

C = Client PC, A = Olympus Activation Server, 1 = RAF file, 2 = PAF file

With Internet-based activation scenario, a RAF file (request activation file) is automatically sent to the
Olympus' central activation server via Internet. This server, provided that the license could be
identified and activated, automatically sends back a PAF file (processed activation file). 

C = Client PC, A = Olympus Activation Hotline, 1 = Code A, 2 = Code B

With the file-based activation scenario, the same files are transferred. However, sending the files is
done manually in this scenario via upload and download from the activation server. With the third
activation scenario, character codes are exchanged, for example by telephone with the Activation
hotline.
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Software activation
The importance of the license key
Any software installation always requires entering license keys. Without a valid license key you
cannot install the software, not even for testing or demo purposes. 

The license key can be found on the license certificate that was delivered with your software. 

Illustration of a license certificate. The license key that is needed for software installation is circled in 
the illustration.

During activation the activation server checks whether the license is valid. If the license is valid, the
activation server sends back a confirmation (e.g. the PAF file when using the Internet-based activa-
tion scenario). With PCs that have an Internet connection, this process runs automatically and is
normally finished within seconds.

You are given exactly one license key for your software. If you also purchased specialized software
extensions, called Solutions, you have been given a separate license certificate with another license
key for each Solution. You must enter these license keys as well during installation.

When does software activation take place?
Having installed the software does not mean that it is automatically activated. If, during software
installation, you chose to activate the software later, you must do this within 30 days of installation
because you won't be able to use the software afterwards without activation. Until you complete the
activation, you are prompted to do so every day during this term. 

Select the Help > Activate licenses... command to activate your software licenses retroactively. This
command is only available if your licenses have not been activated yet. 
13



Software activation 
4-2-2 Internet-based software activation 
If the PC where OLYMPUS Stream is to be used has an Internet connection, the activation is done
directly from this PC. Have your license certificate at hand.

When you start the software installation, the
Provide license keys dialog box automatically
opens.

1) Enter the license key that is given on the
license certificate. 
 If you have more license keys (for

example, for Solutions), enter all of
them. 

2) Click the Next > button. 

3) In the Activate licenses dialog box that is
displayed now, do not change the preset
Activate now (recommended) option and
click the Next button.

4) In the Contact activation server dialog box,
click the Contact Server button.
 The PC will now contact the activation

server and data will be exchanged. This
occurs in the background. This can
take several seconds. Do not interrupt
this process if possible!

 When the dialog box displayed on the
left-hand side is displayed, your soft-
ware has been activated successfully. 

 An HTML file has been saved to you
desktop that contains important infor-
mation regarding your licenses.

5) Print out this HTML file and additionally
save it on another PC to ensure that you
can always access this information.

6) Click the Next button to continue the
software installation. 
14



Software activation
4-2-3 File-based software activation
If the PC where OLYMPUS Stream is to be used has no Internet connection, the activation can be
done via another PC that has an Internet connection. 

To do so, you start the software installation on the first PC and then use a second PC (with an Internet
connection) for data exchange with the Olympus' central activation server. Have your license
certificate at hand.

When you start the software installation, the
Provide license keys dialog box automatically
opens.

1) Enter the license key that is given on the
license certificate. 
 If you have more license keys (for

example, for Solutions), enter all of
them. 

2) Click the Next > button. 

3) In the Activate licenses dialog box that is
displayed now, do not change the preset
Activate now (recommended) option and
click the Next button.

4) In the Contact activation server dialog
box, click the Contact Server button.
 The PC now tries to contact the activa-

tion server. Due to the fact that no
contact can be made, the dialog box
shown on the left-hand side is
displayed:

5) To do so, click the Save Request File...
button. Save the request file in a way that
allows you to access it from the second
PC with the Internet connection (for
example on a network drive or USB
stick). 
 The request file has the RAF file name

extension, for "request activation file".

6) Change over to the PC with Internet
connection, open an Internet browser and
enter the following internet address. 

http://www.olympus-sis.com/file-activation/
 You will see the following website.
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Software activation 
7) If necessary, you can change the website
language.

8) Click the Browse... button and find the
request file. Then click the Upload >
button.
 The website will now be updated. This

may take several seconds.

9) Click the Download Processed File...
button. Save the processed file in a way
that allows you to access it from the PC
where OLYMPUS Stream is being
installed (for example on a network drive
or USB stick). 
 The processed file has the PAF file

name extension, for "processed acti-
vation file".

10)Close the Internet browser again.

11)Change back to the PC where OLYMPUS
Stream is being installed. 

12)In the Exchange files for activation dialog
box that should still be on display, click
the Load Processed File... button.
Browse to the directory in which the
processed file has been saved.
 As soon as the processed file has

been loaded, the Next button
becomes active.

 When the dialog box displayed on the
left-hand side is displayed, your soft-
ware has been activated successfully. 

 An HTML file has been saved to you
desktop that contains important infor-
mation regarding your licenses.

13)Print out this HTML file and additionally
save it on another PC to ensure that you
can always access this information.

14)Click the Next button to continue the
software installation. 
16



Software activation
4-2-4 Code-based software activation
If the PC where OLYMPUS Stream is installed has no Internet connection and if no other PC with an
Internet connection is available either, the activation can be done via transferring and entering
character codes. You can do this via your mobile device (for example, smartphone) or by calling the
Activation hotline. 

Because of the very long codes that must be entered, only choose this scenario when absolutely no
PC with internet connection is available nearby.

When activating the software via telephone, it is a good idea to have the telephone next to the PC on
which you want to activate the software. Then you can read aloud Code A to the Customer Support
Center employee and directly enter the newly created Code B that will be given to you.

When you start the software installation, the
Provide license keys dialog box automatically
opens.

1) Enter the license key that is given on the
license certificate. 
 If you have more license keys (for

example, for Solutions), enter all of
them. 

2) Click the Next > button. 

3) In the Activate licenses dialog box that is
displayed now, do not change the preset
Activate now (recommended) option and
click the Next button.

4) In the Contact activation server dialog
box, click the Contact Server button.
 The PC now tries to contact the activa-

tion server. Due to the fact that no
contact can be made, the dialog box
shown on the left-hand side is
displayed:

5) Select the Avoid this option: Fully manual
activation in case file exchange is not
possible at all with this computer check
box. 

6) Click the Next > button.
 The dialog box below opens.
17



Software activation 
7) Call the Activation hotline during local
office hours. The dialog box displays the
telephone number that is valid for your
location.
 The customer will bear the costs of the

telephone call. 

8) Inform the Customer Support Center
employee that you would like to activate a
software license by telephone.

9) Read aloud Code A.
 Alternatively, you can use your mobile

device (for example, smartphone),
and open this website: 

http://www.olympus-sis.com/code-activation/
 On this website, you can enter Code A

yourself and then click the Send
button. 

10)When you received Code B, click the
Code B... button in the Activate licenses
manually dialog box.
 The Type Code B dialog box opens. 

11)Enter Code B and click the OK button.

12)If you have more than one license, repeat
the last three steps until you entered
Code B for all your licenses.

13)In the Activate licenses manually dialog
box, click the Next button.

14)When the dialog box displayed on the
left-hand side is displayed, your software
has been activated successfully. 
 An HTML file has been saved to you

desktop that contains important infor-
mation regarding your licenses.

15)Print out this HTML file and additionally
save it on another PC to ensure that you
can always access this information.

16)Click the Next button to continue the
software installation. 
18



Connecting the camera and selecting the camera driver
4-3 Connecting the camera and selecting the camera 
driver

1) You may now connect your camera to your PC. With a FireWire camera, plug one end of the
FireWire cable into the jack of the camera connected to the microscope. Plug the other end into
a port on the FireWire board of your PC or laptop.
 The camera is now connected to your computer. The camera driver which was installed

together with the software is used.
 Further information about connecting your camera can be found in your camera manual.

 Installing the camera driver retroactively

1) Answer the question Can Windows connect to Windows Update to search for software? with No,
not this time and click the Next > button. 

2) In the next dialog box, select the Install from a list or specific location (Advanced) and click the
Next > button.

3) In the next dialog box, select the Don't search. I will choose the driver to install. and click the
Next > button.
 The next dialog box shows the correct camera driver.

4) Select the camera driver and click the Next > button.
 A MS-Windows warning message may pop up. 

The information given in this dialog box is not important for the installation. Thus, click the
Continue Anyway button.

5) Follow the instructions in the Found New Hardware Wizard software wizard.

6) In the last dialog box, click the Finish button. 
 The correct camera driver was correctly installed.

If the Found New Hardware Wizard dialog box opens when you connect your camera to your
PC, then the required camera driver was not found. You can now install it retroactively. 
Do the following:
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Starting and configuring your software 
5 Starting and configuring your software

5-1 Starting the software

1) To start the software, doubleclick on this icon located on the MS-Windows desktop.

2) The first time that you start OLYMPUS Stream, you are asked to configure and calibrate the
software.
 You can find more information about this in the next sections.

5-2 Configuring the software

After installing the software, you need to configure your system. OLYMPUS Stream needs this infor-
mation in order to correctly control components, such as the motorized components of the micro-
scope, for example.

Preconditions for the configuration of motorized microscopes as well as 
objective and zoom encoders

• The microscope needs to be connected with the PC which OLYMPUS Stream runs on. Where
the GX or BX microscopes are concerned, you connect the UCB control box to your PC with
an RS232 cable. 

• The microscope control box must be switched on. 
• The interfaces between the microscope (or other motorized components) and the computer

which OLYMPUS Stream runs on must be correctly configured.
• The objective or zoom encoder must be connected to the corresponding control unit. The con-

trol unit must be connected to the PC with a RS232 cable and switched on. 

You can only configure the system if you are logged on to the software with the user rights
Administrator or Power User. If you have installed OLYMPUS Stream yourself, you automat-
ically have administrator rights. 
20



Configuring the software
Specifying which hardware is available
When starting the software for the first time, the Device List dialog box opens automatically. If you
closed it, you can reopen it with the Acquire > Device List command. In this dialog box, select the
hardware that you use. 

 Which entries are shown in this dialog box depends on the hardware components selected
during the software installation. That is why your Device List dialog box may look different to
the image here.

 You can find detailed information on this dialog box in the online help. 

Configuring the specified hardware
After choosing all necessary entries and confirming the selection with OK, the Device Settings dialog
box is shown. 

In this dialog box, you can make further specifications about the hardware that is used. First, specify
which objectives can be found at which position on the nosepiece. 

Only the objectives that you specified here can be selected or, if they are motorized, controlled when
acquiring an image in your software. 

Your software needs to know which objective is used during image acquisition in order to calibrate
the images correctly. 

 You can find detailed information on this dialog box in the online help. 
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Acquiring your first images 
Calibrating the system
Your software offers a calibration wizard to execute several calibration processes. You can only work
optimally with the system when all of the calibration processes have been performed. 

Click the Calibrations... button in the Device Settings dialog box to start the calibration wizard. If you
don't want to calibrate the system right now but at a later time, use the Acquire > Calibrations...
command. 

 Which calibration processes are available depends on the hardware components that were
selected during the software installation. That is why your Calibrations dialog box may look
different to the image here.

5-3 Acquiring your first images

After configuring and calibrating your software, you can acquire images. Do the following:

1) Switch to the Acquisition layout. To do this, you can use the View > Layout > Acquisition
command.

2) On the Microscope Control toolbar, click the button with the objective that you use for the image
acquisition. The information about which objective has been used is necessary for the correct
image calibration. 

 If you're working with a motorized microscope, the objective you've chosen is automatically
brought into the light path. 

3) If you're working with a manual microscope, rotate the objective manually into the light path. 
 Note: When working with manual microscopes, it can be a good idea to display the Image

Calibration dialog box after each image acquisition. To enable this function, select the Confirm
magnification after acquisition check box in the Acquisition Settings dialog box. 
In the Image Calibration dialog box, you can then confirm or change the objective magnifica-
tion you used. This ensures that the image is properly calibrated. You can find detailed
information on this function in the online help.

4) Click the Live button in the Camera Control tool window.
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Acquiring your first images
 The live image is displayed.

5) Go to the required sample position in the live-image. To do so, move the stage (either manually
or by using the Stage Navigator tool window).

6) Bring the sample into focus (either manually or by using the Microscope Control tool window). 

7) Check the color reproduction. If necessary, carry out a white balance. To do so, click the White
Balance on ROI button. 
You can find this button on the Camera Control tool window's toolbar.

8) Check the exposure time. You can either automatically determine the exposure time or enter the
time manually.

9) Select the resolution you want, in the Resolution group. 

10)In the Camera Control tool window, click the Snap button.
 The acquired image is shown in the document group. 
 If a database is open and you haven't changed the default settings, the Insert Image dialog

box opens. 

11)If you don't have an open database, use the File > Save As... command to save the image. Use
the recommended TIF file format.
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Software deactivation 
6 Software deactivation

Deactivation of your software licenses is always done via the Olympus' central activation server, too.
It is important that the software license receives the "deactivated" status on this server. Only then can
this license be activated again.

Just like activation, also the way the deactivation is carried out depends on whether an Internet
connection can be made or not, and from which PC. The same scenarios as with the activation apply:

1) Internet-based deactivation 
 If the PC on which the software should be deactivated has an Internet connection, the deac-

tivation almost automatically takes place. This is the quickest and most uncomplicated
scenario which will be used in most of the cases. 

2) Code-based deactivation
 If the PC on which the software is to be deactivated no Internet connection, the deactivation

takes place via another PC that has an Internet connection. 
This deactivation scenario requires an additional step: One additional file must be uploaded
onto the Olympus' central activation server: the confirmation file that contains the information
that the deactivation was successful. This software license will only get the "deactivated"
status on the activation server after you uploaded this additional file.

3) Code-based deactivation
 If you activated the software via transferring and entering character codes (either by using

your mobile device (for example, smartphone) or by telephone via the Activation hotline),
deactivation must be done code-based, too. 

Regardless of the deactivation scenario used, basically always the same data is exchanged between
the client PC and the activation server. These data do not contain any personal information.

You must deactivate the software if you want to install the same OLYMPUS Stream software
again on the same or on a different PC. Please pay attention to the following hints that are a
part of the Olympus License Information:

Please keep in mind that you need to deactivate your licenses before you 
• use and activate them on another computer
• use a previously created restore point
• restore your system by installing a backup file
• change hardware components of your computer
• reinstall/change your operating system
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Software deactivation
Basic data exchange during software deactivation 
With the first deactivation scenario, the RAF file (request activation file) and the PAF file (processed
activation file) are automatically sent to the Olympus' central activation server via Internet. 

With the second deactivation scenario, the same files are transferred. However, sending the files is
done manually in this scenario via upload and download from the activation server. At the end of the
deactivation procedure, the customer must save and upload another file, the CAF file (confirmation
activation file). 

With the third deactivation scenario, character codes are exchanged, for example by telephone with
the Activation hotline.
25



Internet-based deactivation 
6-1 Internet-based deactivation

1) If you want to deactivate all licenses on
your PC, start Stream and select the Help
> Deactivate Licenses... command.

2) Read the information in this dialog box and
click the Deactivate all Licenses button. 

3) Click the Deactivate button. 
 The PC now contacts the activation

server.
 When the deactivation could be

completed, you will see the Deactiva-
tion successful dialog box.

 On your desktop, updated information
regarding your licenses has been
saved.

4) Print out this HTML file and additionally
save it on another PC to ensure that you
can always access this information.

5) Click the Close button.

Note on file-based and code-based
deactivation

Basically, the file-based and code-based deac-
tivation is very similar to the procedure of the
activation. Therefore, all the steps you have to
perform are not described in detail here.
When you use the file-based deactivation, you
have to upload the confirmation file to the acti-
vation server after the deactivation is finished.
Use the following internet address to access
the activation server:
http://www.olympus-sis.com/file-deactivation/
26



Uninstalling the software
7 Uninstalling the software

What is uninstalled?
Only the OLYMPUS Stream software is uninstalled. If you installed the Microsoft SQL Server
Express database management system, this installation remains on your PC.

Uninstalling the software 

1) Start Microsoft Windows.

2) Place the DVD that has been supplied in your DVD drive.
• If this DVD is not available, please read the information at the end of this chapter.

3) In case the AutoPlay dialog box appears, click the Run setup.exe entry.

4) If the User Account Control dialog box opens, click Yes.

5) When the Decide on multiple installation dialog box opens, select the Maintain imaging software
option. Click the Next > button to continue.
 The Select action dialog box opens.

6) Select the Uninstall imaging software option. Click the Next > button to continue.
 The Optionally deactivate licensesdialog box opens.

7) Select the Deactivate licenses (recommended) option. Click the Next > button to continue.
 Please note: You can uninstall the software without deactivating the license. However, you

can't activate a deactivated license again, if the software is still installed on other PCs.

8) Perform the deactivation (see page 26). 
 The uninstallation starts after the deactivation is completed.
 When the deactivation is complete, a message box opens.

9) Click the Finish button to confirm.
 If you selected a DP21 or DP26 camera during the OLYMPUS Stream installation, the default

EEE1394 device driver has been replaced by an OLYMPUS-specific IEEE1394 device driver.
Please note that the default IEEE1394 device driver doesn't automatically become active
again after the Stream uninstallation. You need to manually refresh the driver in the Device
Manager > Imaging Devices dialog box

If the DVD that has been supplied with your software is not available
You can also use your operating system's functionality to uninstall the software (for example, with
Windows 7 by clicking the Start button at the bottom right and selecting the Control Panel > Programs
> Uninstall a program command). In this case it is mandatory to have the software deactivated in
advance (see page 26), because a deactivation is not possible during the operating system's
uninstallion procedure.

The Microsoft SQL Server Express database management system can only be removed by
using the control panel. Afterwards, your databases can no longer be opened. So, firstly
make absolutely sure that you will either never need the databases again or have made a
complete backup of all databases. Only then should you remove the database management
system!

To uninstall OLYMPUS Stream, log on to your PC as administrator.
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